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Installing ANSYS, Inc. Products and Licensing on One Windows Machine Introduction This tutorial walks you through the most basic installation and licensing configuration: installing ANSYS, Inc. products and licensing on one Windows machine. This tutorial assumes that no ANSYS, Inc. products or licensing have previously been installed on this machine or, if products have been installed, all components, including licensing, have been completely removed. If this scenario does not suit your needs, please see the other tutorials available from the Download Center at https://www1.ansys.com/customer/. You can follow this tutorial while actually installing the products and setting up the license server. To do so, simply make the selections that are pertinent to you or insert your specific information where noted.



Before You Begin We recommend that you have the following information available before you begin this tutorial: •



An account on the ANSYS Customer Portal. If you do not have an account, you may register at https://www1.ansys.com/customer/ to receive your own account.



•



Your license file from ANSYS, Inc., saved to a temporary directory.



•



Open port numbers for both the FLEXlm and ANSYS Licensing Interconnect. Defaults are 1055 and 2325, respectively. To verify that these port numbers are available, open a command line and enter the following command: netstat -a -p tcp



You will see a list of active ports. If 1055 and 2325 are listed, they are already in use and cannot be used for ANSYS, Inc. licensing. In this case, you will need to specify different port numbers where indicated later in this tutorial.



Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.



1



Installing ANSYS, Inc. Products and Licensing on One Windows Machine •



Your local machine's name, to specify as the license server.



You should also verify that you are running on a supported platform. ANSYS, Inc. supports both 32- and 64-bit systems running Windows XP, Vista, and Windows 7. For detailed information on which products are supported on which platforms, please see the ANSYS, Inc. Windows Installation Guide, which is available for download when you download ANSYS, Inc. products or as a printed manual if you receive installation media. Verify that you have sufficient disk space to download, uncompress, and install the products you will be installing. Approximate disk space requirements for each product are shown in the ANSYS, Inc. Windows Installation Guide. If you have any problems with or questions about the installation process please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you. This tutorial is divided into three sets of instructions: •



Product Download Instructions: This set of instructions describes the download and extraction process.



•



Product Installation with Client Licensing: This set of instructions describes the product installation, including the client licensing portion.



•



License Manager Installation: This set of instructions describes the license manager installation.



For this tutorial, both the product and the license manager will be installed on the same machine. You must complete both the client licensing portion and the license manager installation in order to run ANSYS, Inc. products.



Product Download Instructions 1.



From the Customer Portal, click on Download Software.



2.



The ANSYS Download Center Wizard page displays an overview of the download process. Review the overview and click Next.



3.



For the Download Type, choose Current Release. Click Next Step.



4.



Choose the hardware platform for which you want to download installation packages. You can select only one platform at a time. You will need to repeat the download procedure for each platform that you want to download. Click Next Step.
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5.



Choose the products you wish to download. Products are listed by product names that correspond to the licensing product names. You can choose to list products grouped by product group or alphabetically. All products that you currently have licensed are highlighted and pre-selected for your convenience. After you have selected all products that you wish to download, click Next Step.



6.



The license manager, product, and documentation packages that you've selected to download are listed. Click on each link provided to begin the downloads.



7.



After the downloads have completed, uncompress each package using standard uncompression utilities for your specific platform. We strongly recommend that you extract the files into a new, temporary directory.



8.



Begin the product installation as described in the next section.



Product Installation with Client Licensing 1.



Navigate to the directory where you extracted the files. Double-click the setup.exe file. The ANSYS, Inc. Installation Manager appears.



2.



Select the language you want to use. English is the default.



3.



Click the Install ANSYS, Inc. Products button.



4.



The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.
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Installing ANSYS, Inc. Products and Licensing on One Windows Machine



5.
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The directory where you want to install the ANSYS, Inc. products is shown in the Install Directory field. You can install the products into any directory you wish, but you must have write permissions to the directory you choose. The default is C:\Program Files\ANSYS Inc. We recommend using the default directory.
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Leave the Associate file extensions with ANSYS products checkbox marked. This allows you to double-click files from Windows Explorer to launch the various products. Click Next. 6.



All products available in the installation package(s) you downloaded are listed. You can select or deselect any combination of products. ANSYS Workbench is automatically installed with most ANSYS, Inc. products; there is no individual product selection for ANSYS Workbench.



If you select Creo Parametric and/or NX, you will have additional installation steps. This tutorial assumes you are not installing these CAD packages. If you do want to install these products, please see the section Installing ANSYS, Inc. Products in the ANSYS, Inc. Windows Installation Guide for more information on the additional steps required for Creo Parametric and NX. You will also see an estimate of the disk space required to install all of the selected components, and the disk space you have available. The actual amount of disk space required may be less, but if you choose to run the installation with insufficient disk space available, we strongly recommend that you review the log files at the end of the installation to verify that all products were installed correctly. Installation log files are written to the installation directory. Select the products you want to install and click Next. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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Installing ANSYS, Inc. Products and Licensing on One Windows Machine 7.



The dates on the licensing files being installed are compared to any that may already exist on your machine. The more recent set of files will be used. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.



8.
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A summary screen appears that lists everything you have chosen to install. Review this list carefully to verify that it is correct. If it is not, click Back to go to earlier screens to correct the product selections.
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When you have verified the product selections, click Next. When you click Next on this screen, the installation will begin. 9.



As each product package is uncompressed and installed, it will display in the status window. Depending on the number of products you have selected, the installation time required could be lengthy. You will not be able to interrupt the installation process. Please be patient while the installation completes.
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Installing ANSYS, Inc. Products and Licensing on One Windows Machine 10. After all products are installed and configured, the client licensing needs to be run. Click Next to begin the client licensing configuration. A Licensing Client Installation Configuration window appears. Licensing settings are recorded in a configuration file named ansyslmd.ini. This tutorial assumes that licensing has not previously been installed on this machine and therefore the ansyslmd.ini file does not exist. A new screen, Specify the License Server Machine - Add Server Machine Specification appears. You will need to specify the port numbers to be used by the ANSYS licensing. Defaults are provided and will work in most cases. You may need to check with your IT department to confirm that the default port numbers are valid or to get different port numbers if necessary. Then specify the hostname. In this tutorial, you will be configuring your local machine to act as a license server. Type in your machine name and click OK. 11. When the client licensing installation has completed, click Exit. 12. The product installation window reappears with a message noting that the installation is complete. Click Next. 13. On the next screen, you can complete the survey or you can click Finish immediately to skip the survey and complete the product installation. The ANSYS, Inc. Installation Manager appears. You must complete the License Manager installation (next) to run ANSYS, Inc. products.



License Manager Installation Because you will not be using a network server, you must install and configure the ANSYS, Inc. License Manager on your local machine. The License Manager controls access to the ANSYS, Inc. products you have purchased. You must complete the License Manager installation to run ANSYS, Inc. products. 1.
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On the ANSYS, Inc. Installation Manager screen, click Install ANSYS, Inc. License Manager.
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2.



You will see a warning stating that if the license manager is currently running, it will be shut down. This tutorial assumes that you have not previously installed the products or the licensing on this machine, and you are not pointing to a network license server machine. You may safely ignore this message and click OK.



3.



The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.



4.



The directory where the license manager will be installed is shown in the Install Directory field. You cannot specify an installation directory; the license manager must be installed into C:\Program Files\ANSYS Inc. Click Next.



5.



The ANSYS, Inc. License Manager is selected as the only product available to install. As with the product installation, the required and available disk space numbers are shown. Click Next.
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Installing ANSYS, Inc. Products and Licensing on One Windows Machine 6.



The licensing file dates are compared to ensure that the most recent version of the licensing files are being used. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.



7.



A summary screen appears that lists the products to be installed. Because this is a license manager installation, the ANSYS, Inc. License Manager is the only product listed. Click Next. The license manager installation begins.



8.



When the license manager installation completes, click Next to begin the license manager configuration.



9.



The License Server Installation Configuration window appears, and several configuration steps will be completed. When the ANSYS, Inc. License Wizard appears, verify that the Type of License Server selected at the bottom of the screen is Run the ANSYS Licensing Interconnect with FLEXlm (default). Click Continue.



10. The first step is to install a license file. Click Continue. You will then need to specify the location of the license file sent to you by ANSYS, Inc. Use the Browse button on the file locator dialog box to navigate to the location of the license file. 11. Click Continue to configure the local machine as the license server (the default action).



10



Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.



12. Click Continue to start the ANSYS, Inc. License Manager.



13. Click Exit to close the License Wizard. 14. Click Exit to close the Licensing Server Installation Configuration screen. 15. Click Finish to close the License Manager Installation screen. 16. Click Exit to close the ANSYS, Inc. Installation Manager. 17. Choose Start> Programs> ANSYS 14.0>  to launch the ANSYS, Inc. products that you have installed.
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Installing ANSYS, Inc. Products on One Machine and a License Server on Another Machine Introduction This tutorial walks you through installing ANSYS, Inc. products on one Windows machine and installing the ANSYS, Inc. License Manager on a different Windows machine that will act as a license server. This tutorial assumes that no ANSYS, Inc. products or licensing have previously been installed on these machines or, if products have been installed, all components, including licensing, have been completely removed. If this scenario does not suit your needs, please see the other tutorials available on the Download Center at https://www1.ansys.com/customer/. You can follow this tutorial while actually installing the products and setting up the license server. To do so, simply make the selections that are pertinent to you or insert your specific information where noted.



Before You Begin We recommend that you have the following information available before you begin this tutorial: •



An account on the ANSYS Customer Portal. If you do not have an account, you may register at https://www1.ansys.com/customer/ to receive your own account.



•



Your license file from ANSYS, Inc., saved to a temporary directory.



•



Open port numbers for both the FLEXlm and ANSYS Licensing Interconnect on your license server machine. Defaults are 1055 and 2325, respectively. To verify that these port numbers are available, open a command line on the server machine and enter the following command: netstat -a -p tcp
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Installing ANSYS, Inc. Products on One Machine and a License Server on Another Machine You will see a list of active ports. If 1055 and 2325 are listed, they are already in use and cannot be used for ANSYS, Inc. licensing. In this case, you will need to specify different port numbers where indicated later in this tutorial. •



The name of the machine that will act as a license server.



You should also verify that you are running on a supported platform. ANSYS, Inc. supports both 32- and 64-bit systems running Windows XP, Vista, and Windows 7. For detailed information on which products are supported on which platforms, please see the ANSYS, Inc. Windows Installation Guide, which is available for download when you download ANSYS, Inc. products or as a printed manual if you receive installation media. Verify that you have sufficient disk space to download, uncompress, and install the products you will be installing. Approximate disk space requirements for each product are shown in the ANSYS, Inc. Windows Installation Guide. If you have any problems with or questions about the installation process please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you. This tutorial is divided into three sets of instructions: •



Product Download Instructions: This set of instructions describes the download and extraction process.



•



Product Installation with Client Licensing: This set of instructions describes the product installation, including the client licensing portion.



•



License Manager Installation: This set of instructions describes the license manager installation.



For this tutorial, the product and the license manager will be installed on separate Windows machines. You must complete both the client licensing portion and the license manager installation in order to run ANSYS, Inc. products.



Product Download Instructions 1.



From the Customer Portal, click on Download Software.



2.



The ANSYS Download Center Wizard page displays an overview of the download process. Review the overview and click Next.



3.



For the Download Type, choose Current Release. Click Next Step.



4.



Choose the hardware platform for which you want to download installation packages. You can select only one platform at a time. You will need to repeat



14



Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.



the download procedure for each platform that you want to download. Click Next Step. 5.



Choose the products you wish to download. Products are listed by product names that correspond to the licensing product names. You can choose to list products grouped by product group or alphabetically. All products that you currently have licensed are highlighted and pre-selected for your convenience. After you have selected all products that you wish to download, click Next Step.



6.



The license manager, product, and documentation packages that you've selected to download are listed. Click on each link provided to begin the downloads.



7.



After the downloads have completed, uncompress each package using standard uncompression utilities for your specific platform. We strongly recommend that you extract the files into a new, temporary directory.



8.



Begin the product installation as described in the next section.



Product Installation with Client Licensing 1.



Navigate to the directory where you extracted the files. Double-click the setup.exe file. The ANSYS, Inc. Installation Manager appears.



2.



Select the language you want to use. English is the default.



3.



Click the Install ANSYS, Inc. Products button.



4.



The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.
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Installing ANSYS, Inc. Products on One Machine and a License Server on Another Machine



5.
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The directory where you wish to install the ANSYS, Inc. products is shown in the Install Directory field. You can install the products into any directory you wish, but you must have write permissions to the directory you choose. The default is C:\Program Files\ANSYS Inc. We recommend using the default directory.
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Leave the Associate file extensions with ANSYS products checkbox marked. This allows you to double-click files from Windows Explorer to launch the various products. Click Next. 6.



All products available in the installation package(s) you downloaded are listed. You can select or deselect any combination of products. ANSYS Workbench is automatically installed with most ANSYS, Inc. products; there is no individual product selection for ANSYS Workbench.



If you select Creo Parametric and/or NX, you will have additional installation steps. This tutorial assumes you are not installing these CAD packages. If you do want to install these products, please see the section Installing ANSYS, Inc. Products in the ANSYS, Inc. Windows Installation Guide for more information on the additional steps required for Creo Parametric and NX. You will also see an estimate of the disk space required to install all of the selected components, and the disk space you have available. The actual amount of disk space required may be less, but if you choose to run the installation with insufficient disk space available, we strongly recommend that you review the log files at the end of the installation to verify that all products were installed correctly. Installation log files are written to the installation directory. Select the products you want to install and click Next. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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Installing ANSYS, Inc. Products on One Machine and a License Server on Another Machine 7. The dates on the licensing files being installed are compared to any that may already exist on your machine. The more recent set of files will be used. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.



8.
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A summary screen appears that lists everything you have chosen to install. Review this list carefully to verify that it is correct. If it is not, click Back to go to earlier screens to correct the product selections.
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When you have verified the product selections, click Next. When you click Next on this screen, the installation will begin. 9.



As each product package is uncompressed and installed, it will display in the status window. Depending on the number of products you have selected, the installation time required could be lengthy. You will not be able to interrupt the installation process. Please be patient while the installation completes.
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Installing ANSYS, Inc. Products on One Machine and a License Server on Another Machine 10. After all products are installed and configured, the client licensing needs to be run. Click Next to begin the client licensing configuration. A Licensing Client Installation Configuration window appears. Licensing settings are recorded in a configuration file named ansyslmd.ini. This tutorial assumes that licensing has not previously been installed on this machine and therefore the ansyslmd.ini file does not exist. A new screen, Specify the License Server Machine - Add Server Machine Specification appears. You will need to specify the port numbers to be used by the ANSYS licensing. Defaults are provided and will work in most cases. You may need to check with your IT department to confirm that the default port numbers are valid or to get different port numbers if necessary. Then specify the hostname of the machine acting as a license server. Type in that server machine name and click OK. 11. When the client licensing installation has completed, click Exit. 12. The product installation window reappears with a message noting that the installation is complete. Click Next. 13. On the next screen, you can complete the survey or you can click Finish immediately to skip the survey and complete the product installation.



License Manager Installation Because you will be using a network server, you must install and configure the ANSYS, Inc. License Manager on the server machine. The License Manager controls access to the ANSYS, Inc. products you have purchased. 1.



20



On the server machine, navigate to the directory where the installation packages reside. Double-click the setup.exe file. The ANSYS, Inc. Installation Manager appears. Click Install ANSYS, Inc. License Manager.
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2.



You will see a warning stating that if the license manager is currently running, it will be shut down. This tutorial assumes that you have not previously installed the products or the licensing on this machine, and are not already running the ANSYS, Inc. License Manager on this machine. You may safely ignore this message and click OK.



3.



The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.



4.



The directory where the license manager will be installed is shown in the Install Directory field. You cannot specify an installation directory on Windows; the license manager must be installed into C:\Program Files\ANSYS Inc. Click Next.



5.



The ANSYS, Inc. License Manager is selected as the only product available to install. As with the product installation, the required and available disk space numbers are shown. Click Next.



Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.



21



Installing ANSYS, Inc. Products on One Machine and a License Server on Another Machine



6.



The licensing file dates are compared to ensure that the most recent version of the licensing files are being used. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.



7.



A summary screen appears that lists the products to be installed. Because this is a license manager installation, the ANSYS, Inc. License Manager is the only product listed. Click Next. The license manager installation begins.



8.



When the license manager installation completes, click Next to begin the license manager configuration.



9.



The License Server Installation Configuration window appears, and several configuration steps will be completed. When the ANSYS, Inc. License Wizard appears, verify that the Type of License Server selected at the bottom of the screen is Run the ANSYS Licensing Interconnect with FLEXlm (default). Click Continue.
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10. The first step is to install a license file. Click Continue. You will then need to specify the location of the license file sent to you by ANSYS, Inc. Use the Browse button on the file locater dialog box to navigate to the location of the license file. 11. Click Continue to configure the local machine as the license server (the default action).



12. Click Continue to start the ANSYS, Inc. License Manager.
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Installing ANSYS, Inc. Products on One Machine and a License Server on Another Machine



13. Click Exit to close the License Wizard. 14. Click Exit to close the Licensing Server Installation Configuration screen. 15. Click Finish to close the License Manager Installation screen. 16. Click Exit to close the ANSYS, Inc. Installation Manager. 17. From the machine on which the products were installed, choose Start> Programs> ANSYS 14.0>  to launch the ANSYS, Inc. products that you have installed.
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Installing ANSYS, Inc. Products and Licensing on One Linux Machine Introduction This tutorial walks you through installing ANSYS, Inc. products and licensing on one Linux machine. This tutorial assumes that no ANSYS, Inc. products or licensing have previously been installed on this machine or, if products have been installed, all components, including licensing, have been completely removed. If this scenario does not suit your needs, please see the other tutorials available on the Download Center at https://www1.ansys.com/customer/. You can follow this tutorial while actually installing the products and setting up the license server. To do so, simply make the selections that are pertinent to you or insert your specific information where noted.



Before You Begin We recommend that you have the following information available before you begin this tutorial: •



An account on the ANSYS Customer Portal. If you do not have an account, you may register at https://www1.ansys.com/customer/ to receive your own account.



•



Your license file from ANSYS, Inc., saved to a temporary directory.



•



Open port numbers for both the FLEXlm and ANSYS Licensing Interconnect. Defaults are 1055 and 2325, respectively. To verify that these port numbers are available, open a command line and enter the following command: netstat -a -t



You will see a list of active ports. If 1055 and 2325 are listed, they are already in use and cannot be used for ANSYS, Inc. licensing. In this case, you will need to specify different port numbers where indicated later in this tutorial. •



Your local machine's name, to specify as the license server. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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Installing ANSYS, Inc. Products and Licensing on One Linux Machine You should also verify that you are running on a supported platform. ANSYS, Inc. supports both 32- and 64-bit Linux systems running Red Hat 5 and SUSE Linux Enterprise 10 and 11 SP1. For detailed information on which products are supported on which platforms, please see the ANSYS, Inc. Linux Installation Guide, which is available for download when you download ANSYS, Inc. products or as a printed manual if you receive installation media. Verify that you have sufficient disk space to download, uncompress, and install the products you will be installing. Approximate disk space requirements for each product are shown in the ANSYS, Inc. Linux Installation Guide. If you have any problems with or questions about the installation process please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you. This tutorial is divided into three sets of instructions: •



Product Download Instructions: This set of instructions describes the download and extraction process.



•



Product Installation with Client Licensing: This set of instructions describes the product installation, including the client licensing portion.



•



License Manager Installation: This set of instructions describes the license manager installation.



For this tutorial, both the product and the license manager will be installed on the same machine. You must complete both the client licensing portion and the license manager installation in order to run ANSYS, Inc. products.



Product Download Instructions 1.



From the Customer Portal, click on Download Software.



2.



The ANSYS Download Center Wizard page displays an overview of the download process. Review the overview and click Next.



3.



For the Download Type, choose Current Release. Click Next Step.



4.



Choose the hardware platform for which you want to download installation packages. You can select only one platform at a time. You will need to repeat the download procedure for each platform that you want to download. Click Next Step.
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Note If you are not sure which platform you are using, click Which UNIX/Linux platform am I using? to download a small program that identifies your hardware platform. Run this program on all of your UNIX/Linux platforms to see which platform(s) you need to download. The output of this program will match the platform names listed on the Download Center. 5.



Choose the products you wish to download. Products are listed by product names that correspond to the licensing product names. You can choose to list products grouped by product group or alphabetically. All products that you currently have licensed are highlighted and pre-selected for your convenience. After you have selected all products that you wish to download, click Next Step.



6.



The license manager, product, and documentation packages that you've selected to download are listed. Click on each link provided to begin the downloads.



7.



After the downloads have completed, uncompress each package using standard uncompression utilities for your specific platform. We strongly recommend that you extract the files into a new, temporary directory.



8.



Begin the product installation as described in the next section.



Product Installation with Client Licensing 1.



Navigate to the directory where you extracted the files. Run ./INSTALL.



2.



Select the language you want to use. English is the default.
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3.
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The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.
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4.



The directory where you wish to install the ANSYS, Inc. products is shown in the Install Directory field. You can install the products into any directory you wish, but you must have write permissions to the directory you choose. The default is /ansys_inc. We recommend using the default directory. Click Next.
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5.
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All products available in the installation package(s) you downloaded are listed. You can select or deselect any combination of products. ANSYS Workbench is automatically installed with most ANSYS, Inc. products; there is no individual product selection for ANSYS Workbench.



Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.



You will also see an estimate of the disk space required to install all of the selected components, and the disk space you have available. The actual amount of disk space required may be less, but if you choose to run the installation with insufficient disk space available, we strongly recommend that you review the log files at the end of the installation to verify that all products were installed correctly. Installation log files are written to the installation directory. Select the products you want to install and click Next. 6.



The dates on the licensing files being installed are compared to any that may already exist on your machine. The more recent set of files will be installed. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.
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7.



A summary screen appears that lists everything you have chosen to install. Review this list carefully to verify that it is correct. If it is not, click Back to go to earlier screens to correct the product selections. When you click Next on this screen, the installation will begin. When you have verified the product selections, click Next.
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8.



As each product package is uncompressed and installed, it will display in the status window. Depending on the number of products you have selected, the installation time required could be lengthy. You will not be able to interrupt the installation process. Please be patient while the installation completes.



9.



After all products are installed and configured, the client licensing needs to be run. Click Next to begin the client licensing configuration. A Licensing Client Installation Configuration window appears. Licensing settings are recorded in a configuration file named ansyslmd.ini. This tutorial assumes that licensing has not previously been installed on this machine and therefore the ansyslmd.ini file does not exist. A new screen, Specify the License Server Machine - Add Server Machine Specification appears. You will need to specify the port numbers to be used by the ANSYS licensing. Defaults are provided and will work in most cases. You may need to check with your IT department to confirm that the default port numbers are valid or to get different port numbers if necessary. Then specify the hostname. In this tutorial, you will be configuring your machine to act as a license server. Type in your machine name and click OK.
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10. When the client licensing installation has completed, click Exit on the Licensing Client Installation Configuration window. 11. The product installation window reappears with a message noting that the installation is complete. Click Next. 12. On the next screen, you can complete the survey or you can click Finish immediately to skip the survey and complete the product installation.



License Manager Installation Because you will not be using a network server, you must install and configure the ANSYS, Inc. License Manager on your machine. The License Manager controls access to the ANSYS, Inc. products you have purchased. 1.



Navigate to the directory where you extracted the files. Run ./INSTALL.LM.



2.



Select the language you want to use. English is the default.



3.



You will see a warning stating that if the license manager is currently running, it will be shut down. This tutorial assumes that you have not previously installed the products or the licensing on this machine, and you are not pointing to a network license server machine. You may safely ignore this message and click OK.



4.



The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.
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5.



The directory where you wish to install the ANSYS, Inc. License Manager is shown in the Install Directory field. You can install the products into any directory you wish, but you must have write permissions to the directory you choose. The default is /ansys_inc. We recommend using the default directory. You must use the same directory where the products were installed.



6.



The ANSYS, Inc. License Manager is selected as the only product available to install. As with the product installation, the required and available disk space numbers are shown. Click Next.



7.



The licensing file dates are compared to ensure that the most recent version of the licensing files are being used. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.



8.



A summary screen appears that lists the products to be installed. Because this is a license manager installation, the ANSYS, Inc. License Manager is the only product listed.
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Installing ANSYS, Inc. Products and Licensing on One Linux Machine Click Next. The license manager installation begins. 9.



When the license manager installation completes, click Next to begin the license manager configuration.



10. The License Server Installation Configuration window appears, and several configuration steps will be completed. When the ANSYS, Inc. License Wizard appears, verify that the Type of License Server selected at the bottom of the screen is Run the ANSYS Licensing Interconnect with FLEXlm (default). Click Continue.



11. The first step is to install a license file. Click Continue. You will then need to specify the location of the license file sent to you by ANSYS, Inc. Use the Browse button on the file locater dialog box to navigate to the location of the license file. 12. Click Continue to configure the local machine as the license server (the default action).
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13. Click Continue to start the ANSYS, Inc. License Manager.
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Installing ANSYS, Inc. Products and Licensing on One Linux Machine 14. Click Exit to close the License Wizard. 15. Click Exit to close the Licensing Server Installation Configuration screen. 16. Click Finish to close the License Manager Installation screen. 17. Click Exit to close the ANSYS, Inc. Installation Manager. 18. Open a terminal window and navigate to your ANSYS installation. The following table lists the default paths to start the ANSYS products you have installed.



Application Locations Application



How to Launch



CFD Post



/shared/postrel/ansys_inc/v130/cfdpost



CFX



/shared/postrel/ansys_inc/v130/CFX/bin/ Where  can be cfx5, cfx5launch, cfx5pre, cfxsolve, or cfx5post.



FLUENT



/shared/postrel/ansys_inc/v130/fluent/bin/fluent



ICEM-CFD



/shared/postrel/ansys_inc/v130/icemcfd/icemcfd



ICEPAK



/shared/postrel/ansys_inc/v130/icepak/icepak



PolyFlow



/shared/postrel/ansys_inc/v130/polyflow/bin/polyflow



Turbogrid



/shared/postrel/ansys_inc/v130TurboGrid/bin/cfxtg



Workbench



/shared/postrel/ansys_inc/v130/Framework/bin/Linux64/runwb2or /shared/postrel/ansys_inc/v130/Framework/bin/Linux32/runwb2
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Installing Redundant (Triad) License Servers Introduction This tutorial walks you through installing the ANSYS, Inc. License Manager on three Linux machines which will act as redundant (triad) license servers, and then installing the ANSYS, Inc. products and client licensing on each end user's machine and configuring users to point to these servers. This tutorial assumes that no ANSYS, Inc. products or licensing have previously been installed on these machines or, if products have been installed, all components, including licensing, have been completely removed. This tutorial is intended to be used by a site's system administrator or IT professional who will be installing and configuring products and licensing for site-wide use. If this scenario does not suit your needs, please see the other tutorials available on the Download Center at https://www1.ansys.com/customer/. You can follow this tutorial while actually installing the products and setting up the license servers. To do so, simply make the selections that are pertinent to you or insert your specific information where noted.



Before You Begin We recommend that you have the following information available before you begin this tutorial: •



An account on the ANSYS Customer Portal. If you do not have an account, you may register at https://www1.ansys.com/customer/ to receive your own account.



•



Your license file from ANSYS, Inc., saved to a temporary directory.



•



Open port numbers for both the FLEXlm and ANSYS Licensing Interconnect on your license server machine. Defaults are 1055 and 2325, respectively. To verify that these port numbers are available, open a command line on the server machine and enter the following command: netstat -a -t
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Installing Redundant (Triad) License Servers You will see a list of active ports. If 1055 and 2325 are listed, they are already in use and cannot be used for ANSYS, Inc. licensing. In this case, you will need to specify different port numbers where indicated later in this tutorial. •



The name of the machines that will act as license servers.



You should also verify that you are running on a supported platform. ANSYS, Inc. supports both 32- and 64-bit Linux systems running Red Hat 5 and SUSE Linux Enterprise 10 and 11 SP1. For detailed information on which products are supported on which platforms, please see the ANSYS, Inc. Linux Installation Guide, which is available for download when you download ANSYS, Inc. products or as a printed manual if you receive installation media. Verify that you have sufficient disk space to download, uncompress, and install the products you will be installing. Approximate disk space requirements for each product are shown in the ANSYS, Inc. Linux Installation Guide. If you have any problems with or questions about the installation process please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you. This tutorial is divided into three sets of instructions: •



Product Download Instructions: This set of instructions describes the download and extraction process.



•



License Manager Installation: This set of instructions describes the license manager installation and triad configuration.



•



Product Installation with Client Licensing: This set of instructions describes the product installation, including the client licensing portion.



You must complete both the client licensing portion and the license manager installation in order to run ANSYS, Inc. products.



Product Download Instructions 1.



From the Customer Portal, click on Download Software.



2.



The ANSYS Download Center Wizard page displays an overview of the download process. Review the overview and click Next.



3.



For the Download Type, choose Current Release. Click Next Step.



4.



Choose the hardware platform for which you want to download installation packages. You can select only one platform at a time. You will need to repeat
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the download procedure for each platform that you want to download. Click Next Step.



Note If you are not sure which platform you are using, click Which UNIX/Linux platform am I using? to download a small program that identifies your hardware platform. Run this program on all of your UNIX/Linux platforms to see which platform(s) you need to download. The output of this program will match the platform names listed on the Download Center. 5.



Choose the products you wish to download. Products are listed by product names that correspond to the licensing product names. You can choose to list products grouped by product group or alphabetically. All products that you currently have licensed are highlighted and pre-selected for your convenience. After you have selected all products that you wish to download, click Next Step.



6.



The license manager, product, and documentation packages that you've selected to download are listed. Click on each link provided to begin the downloads.



7.



After the downloads have completed, uncompress each package using standard uncompression utilities for your specific platform. We strongly recommend that you extract the files into a new, temporary directory.



8.



Begin the product installation as described in the next section.



License Manager Installation and Triad Configuration To use a redundant server configuration of three machines, you must install and configure the ANSYS, Inc. License Manager on each of the three server machines. The License Manager controls access to the ANSYS, Inc. products you have purchased. 1.



On each server machine, navigate to the directory where the installation packages reside. Run the ./INSTALL.LM file.



2.



You will see a warning stating that if the license manager is currently running, it will be shut down. This tutorial assumes that you have not previously installed the products or the licensing on these machines, and are not already running the ANSYS, Inc. License Manager on these machines. You may safely ignore this message and click OK. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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Installing Redundant (Triad) License Servers 3.



The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.



4.



The directory where you wish to install the ANSYS, Inc. License Manager is shown in the Install Directory field. You can install the products into any directory you wish, but you must have write permissions to the directory you choose. The default is /ansys_inc. We recommend using the default directory.



5.



The ANSYS, Inc. License Manager is selected as the only product available to install. The required and available disk space numbers are shown. Verify that you have sufficient disk space to install the license manager and click Next.



6.



The licensing file dates are compared to ensure that the most recent version of the licensing files are being used. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.



7.



A summary screen appears that lists the products to be installed. Because this is a license manager installation, the ANSYS, Inc. License Manager is the only product listed.
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Click Next. The license manager installation begins. 8.



When the license manager installation completes, click Next to begin the license manager configuration.



9.



The License Server Installation Configuration window appears, and several configuration steps will be completed. When the ANSYS, Inc. License Wizard appears, verify that the Type of License Server selected at the bottom of the screen is Run the ANSYS Licensing Interconnect with FLEXlm (default). Click Continue.



10. The first step is to install a license file. Click Continue. You will then need to specify the location of the license file sent to you by ANSYS, Inc. Use the Browse button on the file locater dialog box to navigate to the location of the license file. All three server machines must install the same license file. 11. Click Continue to configure the local machine as the license server (the default action).
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12. Click Skip to bypass starting the ANSYS, Inc. License Manager.
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13. Click Exit to close the License Wizard. 14. Click Exit to close the Licensing Server Installation Configuration screen. 15. Click Finish to close the License Manager Installation screen. 16. Repeat this installation on all three license server machines. 17. When all three license server machines have the license manager installed, start the license manager on all of them, starting with the primary license server machine (the machine listed first in the license file). To start the license manager, use the Start the License Manager option of the ANSLIC_ADMIN utility: 1.



On each license server machine, run the following command to start the ANSLIC_ADMIN utility: /ansys_inc/shared_files/licensing/lic_admin/anslic_admin



2.



Choose Start the ANSYS, Inc. License Server.



Product Installation with Client Licensing You will now install the products and client licensing on each user's machine. This tutorial assumes that the client machines are Windows machines. The process is similar on Linux clients; see the ANSYS, Inc. Linux Installation Guide for detailed installation instructions for installing the products and client licensing on Linux machines. Follow the steps below on each user's machine. 1.



Navigate to the directory where you extracted the files. Double-click the setup.exe file. The ANSYS, Inc. Installation Manager appears.



2.



Select the language you want to use. English is the default.



3.



Click the Install ANSYS, Inc. Products button. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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Installing Redundant (Triad) License Servers 4.



The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.



5.



The directory where you wish to install the ANSYS, Inc. products is shown in the Install Directory field. You can install the products into any directory you wish, but you must have write permissions to the directory you choose. The default is C:\Program Files\ANSYS Inc. We recommend using the default directory.
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Leave the Associate file extensions with ANSYS products checkbox marked. This allows you to double-click files from Windows Explorer to launch the various products. Click Next. 6.



All products available in the installation package(s) you downloaded are listed. You can select or deselect any combination of products. ANSYS Workbench is automatically installed with most ANSYS, Inc. products; there is no individual product selection for ANSYS Workbench.



If you select Creo Parametric and/or NX, you will have additional installation steps. This tutorial assumes you are not installing these CAD packages. If you do want to install these products, please see the section Installing ANSYS, Inc. Products in the ANSYS, Inc. Windows Installation Guide for more information on the additional steps required for Creo Parametric and NX. You will also see an estimate of the disk space required to install all of the selected components, and the disk space you have available. The actual amount of disk space required may be less, but if you choose to run the installation with insufficient disk space available, we strongly recommend that you review the log files at the end of the installation to verify that all products were installed correctly. Installation log files are written to the installation directory. Select the products you want to install and click Next. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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The dates on the licensing files being installed are compared to any that may already exist on your machine. The more recent set of files will be installed. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.



8.
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A summary screen appears that lists everything you have chosen to install. Review this list carefully to verify that it is correct. If it is not, click Back to go to earlier screens to correct the product selections.
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When you have verified the product selections, click Next. When you click Next on this screen, the installation will begin. 9.



As each product package is uncompressed and installed, it will display in the status window. Depending on the number of products you have selected, the installation time required could be lengthy. You will not be able to interrupt the installation process. Please be patient while the installation completes.
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Installing Redundant (Triad) License Servers 10. After all products are installed and configured, the client licensing needs to be run. Click Next to begin the client licensing configuration. A Licensing Client Installation Configuration window appears. Licensing settings are recorded in a configuration file named ansyslmd.ini. This tutorial assumes that licensing has not previously been installed on this machine and therefore the ansyslmd.ini file does not exist. A new screen, Specify the License Server Machine - Add Server Machine Specification appears. You will need to specify the port numbers to be used by the ANSYS licensing. Defaults are provided and will work in most cases. You may need to confirm that the default port numbers are valid or to use different port numbers if necessary. Click 3-server (redundant triad). The three Hostname fields will become active. Specify the hostname (server machine name) of the machines acting as license servers (one in each Hostname field). Specify the hostnames in the same order as the machines appear in your license file. Click OK. 11. When the client licensing installation has completed, click Exit. 12. The product installation window reappears with a message noting that the installation is complete. Click Next. 13. On the next screen, you can complete the survey or you can click Finish immediately to skip the survey and complete the product installation.
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Installing and Configuring RSM to Use Microsoft HPC and Running via Mechanical and/or Mechanical APDL Application Introduction This tutorial walks you through the process of configuring Remote Solve Manager (RSM) to use a Microsoft HPC cluster as the compute server for a Mechanical or Mechanical APDL remote solution. If this scenario does not suit your needs, please see the other tutorials available on the Download Center at www.ansys.com. You can follow this tutorial while actually configuring RSM. To do so, use the selections that are pertinent to you or insert your specific information where noted.



Before You Begin These instructions assume the following: •



You have established and configured a Microsoft HPC cluster. If Microsoft HPC is not configured properly, contact Microsoft for support before you attempt to install ANSYS. You can also download Getting Started Guide for Windows HPC Server 2008 at http://technet.microsoft.com/en-us/library/cc793950.apsx. This guide is also available with the installation files for Microsoft HPC Pack 2008 (HPGettingStarted.rtf, in the root folder.)



•



You have Administrative privileges on the head node of the HPC cluster you are configuring.



•



You have the machine name of the HPC head node.



•



You have the machine name of the head node on the Microsoft HPC cluster.
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Installing and Configuring RSM to Use Microsoft HPC and Running via Mechanical and/or Mechanical APDL Application • You have already configured and verified communications between RSM and the HPC head node. See the HPC installation tutorials in the Download Software section of the ANSYS Customer Portal, at https://www1.ansys.com/customer/. •



RSM is installed on the HPC head node. This allows you to use both the Solve Manager and Compute Server (also known as ScriptHost) services, or just use the Compute Server service. If you choose the latter, the Solve Manager runs on the RSM Client machine, or on a central, dedicated Solve Manager machine.



•



You are able to install and run ANSYS, Inc. products, including Licensing, on both Windows and Linux systems. For information on product and licensing installations, see the RSM tutorials on the Download Software section of the ANSYS Customer Portal, at https://www1.ansys.com/customer/ to install ANSYS, Inc.



If you have any problems with or questions about the installation process please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you. This tutorial is divided into five sets of instructions: 1.



Configure Multiple Network Cards



2.



Set Up the HPC Head Node to Communicate with RSM and Test



3.



Configure RSM on the Microsoft HPC Head Node



4.



Configure RSM on the RSM Client Machine



5.



Submit an RSM Job from an RSM Client



Configure Multiple Network Cards If your Microsoft HPC Cluster is configured using multiple network cards where there is more than one network defined, you must edit some configuration files on the head node to explicitly define the IP address of the head node. 1.



On the client machine, ping the head node using the fully qualified domain name: C:\>ping headnode.domain.com



The ping



command should return a statement similar to the following: Pinging multiNICmachine.domain.com [10.2.10.32] with 32 bytes of data: Reply from 10.2.10.32: bytes=32 time=56ms TTL=61



52



Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.



Note the IP address (10.2.10.32 in the above example). You will need this address in the following steps. 2.



Navigate on the head node to C:\Program Files\Ansys Inc\V140\RSM\bin and locate the Ans.Rsm.JMHost.exe.config and Ans.Rsm.SHHost.exe.config files.



3.



Open both files in a text editor.



4.



Add the IP address from step 1 to the TCP channel configuration: ...        ...



Set Up the HPC Head Node to Communicate with RSM and Test Run the following steps on the head node of the Microsoft HPC cluster to configure the head node to communicate with the slave nodes. The last step is a test to verify that communications between the head node and the slave nodes are working correctly. If the test fails, you must resolve any errors before continuing with this tutorial. 1.



Install ANSYS, Inc. products on the head node of the Microsoft HPC cluster. This machine will act as the RSM Manager and the Compute Server. See the tutorials on the Download Center at www.ansys.com for detailed instructions on installing ANSYS, Inc. products.



2.



Double-click C:\Program Files\Ansys Inc\V140\commonfiles\MPI\MicrosoftHPC2008\Config_ANSYSMech.bat on the head node to configure all compute nodes.



3.



Run the following from a command prompt on the Microsoft HPC head node: clusrun mkdir C:\Temp\%USERNAME%\Work



This step creates the necessary working directory on all nodes. Copy the RUNANSYS.xml, runansys.bat, spar.inp, and pcg.inp files to C:\TEMP\%USERNAME% on the head node. These files will allow you to run the test in the next step. These files are located in the
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Installing and Configuring RSM to Use Microsoft HPC and Running via Mechanical and/or Mechanical APDL Application C:\Program Files\Ansys Inc\V140\commonfiles\MPI\MicrosoftHPC2008 directory by default. 4.



54



Test the connections from the head node to the compute nodes: 1.



Open the HPC Cluster Manager. Select Job Management from the menu on the left side of the screen.



2.



Select Actions>Create New Job from Description File... from the menu side on the right side of the screen.
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3.



Navigate to C:\TEMP\%USERNAME%\RUNANSYS.xml and click Submit.



The job submitted by RUNANSYS.xml will run for several minutes. If it quits immediately, the job failed. Please check the C:\TEMP\TaskStdOut.txt for errors.
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Installing and Configuring RSM to Use Microsoft HPC and Running via Mechanical and/or Mechanical APDL Application



4. 5.



Close the HPC Cluster Manager.



If the test in the previous step runs successfully, continue to the next section.



Configure RSM on the Microsoft HPC Head Node Run the following steps on the head node of the Microsoft HPC cluster to configure RSM. The last step is a test to verify that RSM is working correctly on the head node. If the test fails, you must resolve any errors before continuing with this tutorial. 1.



Navigate to the \RSM\bin directory and run the following from a command prompt to configure and start the RSM services on the head node: AnsConfigRSM.exe -mgr -svr



By default, AnsConfigRSM.exe is found in C:\Program Files\Ansys Inc\V140\RSM\bin. 2.



Set your RSM password. This is the password RSM will use to run jobs on the Compute Server. Note that you need to update your RSM password when you update your password on the RSM client machine. 1.
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Open RSM (Start> Programs> ANSYS 14.0> Utilities> Remote Solve Manager).
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2.



3.



Right-click on My Computer [Set Password] in the RSM tree and select Set Password to set the password for the user specified in the previous step. A command prompt will open prompting for the user’s password.



Add the Microsoft HPC head node as a Compute Server: 1.



Right-click on Compute Servers in the RSM tree and select Add.



2.



In the Compute Server Properties window, enter the following information under the General Tab: •



Enter a Display name for the server; this name can be any name that makes sense for you. This example will use MS Compute Cluster.



•



Enter the machine name. This name must be the actual computer name of the head node. This example will use dellwinhpc.



•



Set the Working Directory Location to Automatically Determined.
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3.
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Enter the following information under the Cluster Tab: •



Set the Cluster Type to Windows HPC.



•



Set the Shared Cluster Directory to the directory that is shared out to all the cluster nodes from the Headnode. This example will use the shared temp directory \\dellwinhpc\temp.



•



Set the File Management to Use Execution Node Local Disk.
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4. 4.



Click OK to close the Compute Server Properties window.



Add a queue: 1.



Right-click on Queues in the RSM tree and select Add.



2.



In the Queue Properties window, under General, enter a name for this queue. In this example, we will use dellwinhpc.



3.



The Compute Server you added previously (dellwinhpc in this example) appears under Assigned Servers. Check the box next to it.
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60



4.



Click Ok on the Queue Properties window.



5.



In the RSM tree, expand the Compute Servers item to see the Compute Server you added (dellwinhpc in this example).
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6.



Right-click Compute Server>dellwinhpc and select Test Server to test the connection and view a report of any problems.



7.



If the test in the previous step runs successfully, continue to the next section.



Configure RSM on the RSM Client Machine Run the following steps from each RSM client (end user) machine that will be submitting RSM jobs to the Microsoft HPC cluster. The last step is a test to verify that communication between the head node and the client machine is working correctly. If the test fails, you must resolve any errors before continuing with this tutorial. 1.



Install ANSYS, Inc. products on each client machine that will be submitting RSM jobs to the Microsoft HPC cluster. When installing, be sure to choose a product that includes ANSYS Workbench. See the tutorials on the Download Center at www.ansys.com for detailed instructions on installing ANSYS, Inc. products.



2.



Open RSM (Start> Programs> ANSYS 14.0> Utilities> Remote Solve Manager.
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Installing and Configuring RSM to Use Microsoft HPC and Running via Mechanical and/or Mechanical APDL Application 3. Right-click on My Computer [Set Password] in the RSM tree on the client machine and select Set Password to set the password for the client machine. A command prompt will open prompting for the user’s password. 4.



Select Tools> Options. In the Name field, add the name of the head node (dellwinhpc from Step 3, substep 2 of Configure RSM on the Microsoft HPC Head Node, above). Click Add, then click OK.



Note Users do not need to add compute machines or queues; RSM will pick up that information automatically from the head node. If the head node appears in red in the tree with a red X next to it, there is a connection problem.
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5.



Right-click on the head node listed in the RSM tree view (dellwinhpc [Set Password] in this example) and select Set Password to set the password for the client on the head node. A command prompt will open prompting for the user’s password.



6.



Test the client-server connection by selecting dellwinhpc>Compute Server>dellwinhpc> Test Server in the RSM tree on the client machine.



7.



If the test in the previous step runs successfully, continue to the next section.



Submit an RSM Job from an RSM Client 1.



Install ANSYS, Inc. products on each client machine that will be submitting RSM jobs to the MSCC cluster. When installing, be sure to choose a product that includes ANSYS Workbench.



2.



Open ANSYS Workbench (Start> Programs> ANSYS 14.0> ANSYS Workbench). Add a Mechanical system and assign a geometry, establish all necessary loads, etc. See the Workbench User Guide or the Mechanical User Guide for more information on setting up a Mechanical analysis in ANSYS Workbench.



3.



Double-click the Model or Setup cell to launch Mechanical.



4.



In the Mechanical window, select Tools> Solve Process Settings.
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5.



On the Solve Process Settings dialog, click Add Remote.



6.



Enter a Solve Process Setting Name. This name can be any name of your choosing. This example will use dellwinhpc.



7.



Click OK.



8.



Select the Solve Process Setting name you just specified from the list on the left.
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1.



Under Computer Settings, enter the machine name of the head node (dellwinhpc in this example) as the Solve Manager.



2.



Select the queue from the Queue drop-down list (in this example we created the MS Compute Cluster in the RSM configuration step).
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9.



3.



Click Advanced.



4.



On the Advanced dialog, click Distribute Solution (if possible) and specify the number of processors. Click OK to close the Advanced dialog.



Click OK to complete the Solve Process setup.



10. Finish setting up your analysis. When the model is set up and ready to solve, open/launch Mechanical and select the Solve toolbar button dropdown arrow. You will see your solve process name. Select that process.
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11. The solve will commence. When the solution has completed, the Solution items in the project tree will have a down arrow next to them. 12. Right-click on the Solution Branch and select Get Results to bring the solution items down to the local machine.
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Installing and Configuring Native RSM to Use a Linux LSF or PBS Cluster and Running via Mechanical and/or Mechanical APDL Application Introduction This tutorial walks you through process of configuring Remote Solve Manager (RSM) to use “native mode” for a Linux Platform LSF (Load Sharing Facility) or PBS (Portable Batch System) cluster. “Native mode” in a cluster environment means that RSM is installed and running locally on the headnode of the Linux cluster. The benefit to using native mode RSM is that communication protocols such as SSH are not necessary for communications between a Windows Compute Server and a Linux Compute server. In this example, both the Solve Manager and the Compute Server services will be running on the head node of the Linux cluster. Once you’ve tested your configuration, you can follow the steps for submitting a Mechanical or Mechanical APDL job to RSM. If this scenario does not suit your needs, please see the other tutorials available in the Download Software section of the ANSYS Customer Portal at https://www1.ansys.com/customer/. You can follow this tutorial while actually configuring RSM. To do so, simply make the selections that are pertinent to you or insert your specific information where noted.



Before You Begin These instructions assume the following: •



Both the Windows and the Linux machines are set up correctly on the network.



•



You are not using the SSH protocol but instead are using native RSM (TCP/IP for Windows-Linux communications). For information on native RSM, see Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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Installing and Configuring Native RSM to Use a Linux LSF or PBS Cluster and Running via Mechanical and/or Mechanical APDL Application Configuring RSM to Use a Remote Computing Mode for Linux in the Remote Solve Manager User’s Guide.



Note If you are using SSH, please refer to Appendix A: Integrating Windows with Linux using SSH/SCP in the Remote Solve Manager User’s Guide for instructions. •



An LSF or PBS Linux cluster has been established and configured.



•



The LSF or PBS submission host is a node on the Linux cluster you’re configuring for which bsub and lsrcp (requires RES service) commands are available. For the LSF or PBS submission host: –



You have administrative privileges of the submission host.



–



You have the machine name of the submission host.



–



RSM has been installed on the submission host.



•



Both ANSYS Workbench and RSM have been installed on the Windows machine.



•



You are able to install and run ANSYS, Inc. products, including Licensing, on both the Solve Manager and Compute Server machines. For information on product and licensing installations, see the RSM tutorials on the Download Software section of the ANSYS Customer Portal at https://www1.ansys.com/customer/.



If you have any problems with, or questions about the installation process, please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you. This tutorial is divided into the following procedures: •



Add the Linux Submission Host as Solve Manager (p. 69)



•



Set Your RSM Password (p. 70)



•



Add the Linux Submission Host as Compute Server (p. 70)



•



Add a Queue (p. 74)



•



Test the Compute Server Configuration (p. 75)



•



Submit an RSM Job from an RSM Client (p. 76)
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Add the Linux Submission Host as Solve Manager Perform the following steps on your Windows RSM Client machine to configure the Linux submission host as the Solve Manager. This example uses the submission host of an LSF Linux cluster, so you must set your Solve Manager to the hostname of the LSF cluster head node. 1.



Open RSM by from the Start menu (select Start > Programs > ANSYS 14.0 > Utilities > Remote Solve Manager).



2.



From the RSM menu bar, select Tools > Options.



3.



In the Options dialog, add the hostname of the cluster headnode if it is not already there. Type the host name into the Name field and click the Add button. In this example, the name of the headnode is lsfclusternode.



4.



In the Solve Managers section, select the check box next to lsfclusternode.



5.



Click the OK button.
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Set Your RSM Password Perform the following steps on your Windows RSM Client machine to set your RSM password. This is the password RSM will use to run jobs on the Compute Server. Note that you need to update your RSM password when you update your password on the RSM Client machine. 1.



In the RSM tree view, right-click on the lsfclusternode [Set Password] node and select Set Password.



2.



A command prompt will open, asking you for username and password. Follow the instructions in the prompt.



3.



In the RSM tree view, verify that lsfclusternode is no longer followed by [Set Password].



Add the Linux Submission Host as Compute Server Perform the following steps on your Windows RSM Client machine to configure RSM to use an LSF or PBS cluster. In this section, we are adding a Linux submission host as the Compute Server. 1.



70



Underneath the Solve Manager node on the RSM tree view, right-click on the Compute Servers node and select Add.
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The Compute Server Properties dialog is displayed. 2.



On the General tab of the Compute Server Properties dialog, set properties as follows: •



For the Display Name property, enter a descriptive name for the Linux machine being defined as a Compute Server. This example will use Linux Host.



•



In this example, the Compute Server services will be on the submission host of the cluster, so in this example we will set Machine Name to the hostname or IP address of the Linux machine that will the Compute Server (the same machine name used for the Solve Manager). This name must be the actual computer name of the Solve Manager. In this example, the hostname is lsfclusternode.



•



For the Working Directory Location property, specify whether the system will determine the location. In this example, we will select Automatically Determined to allow the system to determine the location; you do not need enter a Working Directory path.



•



The Working Directory property is blank and disabled if the Working Directory Location is Automatically Determined, as in this example.
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3.



On the Cluster tab of the Compute Server Properties dialog, set properties as follows: •



Set the Cluster Type property. In this example, we’ll select LSF.



•



For the Shared Cluster Directory property, enter the path to your central file-staging directory. The Shared Cluster Directory is on the machine defined on the General tab. The RSM job creates a temporary directory here. Mount this directory on all execution hosts so that the LSF or PBS job has access.



•
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For the File Management property, specify whether you want to store temporary solver files on the Shared Cluster Directory or on locally on the execution node. In this example, we’ll select Reuse Shared Cluster Directory to store temporary solver files in the Shared Cluster Directory.
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Note When you select this option, the Shared Cluster Directory and the Working Directory are in the same location. As such, the Shared Cluster Directory path will be populated to the Working Directory Path property on the General tab. Also, the Working Directory Location property on the General tab will be set to Automatically Determined. See the image below.



Note The directories you enter here must match the directory names exactly. If the directory names do not match exactly, the process will fail.
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Installing and Configuring Native RSM to Use a Linux LSF or PBS Cluster and Running via Mechanical and/or Mechanical APDL Application Since you are not using the SSH protocol, you do not need to fill anything out on SSH tab. (The Use SSH check box is deselected by default.) 4.



Click the OK button to close the Compute Server Properties dialog.



5.



In the RSM tree view, expand the Compute Servers node to view the Compute Server you added (Linux Host in this example).



Add a Queue 1.



In the RSM tree view, right-click on the Queues node and select Add.



2.



Under General in the Queue Properties dialog, enter a Name for this queue. In this example, we will use Linux LSF Queue.



Note The RSM Queue Name must match the Queue Name in LSF. 3.
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The Compute Server you added previously (Linux Host in this example) appears under Assigned Servers. Select the check box next to it to assign the server to this queue.
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4.



Click the OK button to close the Queue Properties dialog.



5.



In the RSM tree view, expand the Queues node to view the queue you added (Linux LSF Queue in this example).



Test the Compute Server Configuration This step is a test to verify that RSM is working correctly. If the test fails, you must resolve any errors before continuing with this tutorial. Administrative privileges are required to perform these steps. 1.



On the lsfclusternode, make a backup of the file GenericJobTP.cs located under /ansys_inc/v130/RSM/Config/scripts.



2.



Open GenericJobTP.cs in an editor.



3.



Search for the last instance of the word “normal”. The word should be in the section as shown below: //NOTE: This is here to make server tests work properly. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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Installing and Configuring Native RSM to Use a Linux LSF or PBS Cluster and Running via Mechanical and/or Mechanical APDL Application //CUSTOMIZE to test to another queue. //Actual jobs use the RSM queue name. if (queueName=="Immediate") { if (Task.ProxyKeyword.Contains"LSF")) { queueName="normal";



4.



Replace the word normal with the actual name of the LSF queue and save the file.



5.



In the RSM tree view, expand the Compute Servers node.



6.



Right-click on the newly added Compute Server and select Test Server.



7.



When the test job completes, you can view job details in the RSM Progress Pane. If the test runs successfully, continue to the next section.



Submit an RSM Job from an RSM Client 1.



Install ANSYS, Inc. products on each client machine that will be submitting RSM jobs to the Linux cluster. When installing, be sure to choose a product that includes ANSYS Workbench.



2.



Open ANSYS Workbench (Start> Programs > ANSYS 14.0 > ANSYS Workbench). Add a Mechanical system and assign a geometry, establish all necessary loads, etc. See the Workbench User’s Guide for more information.
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3.



On the analysis system on the Project Schematic, double-click either the Model or the Setup cell to launch Mechanical.



4.



In the Mechanical window, select Tools > Solve Process Settings from the main menu.



5.



On the Solve Process Settings dialog, click the Add Remote button.



6.



On the Rename Solve Process Settings dialog that opens:



7.



•



Enter a Solve Process Setting Name. This can be any name of your choosing. This example will use Linux Cluster.



•



Click the OK button to close the Rename Solve Process Settings dialog.
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77



Installing and Configuring Native RSM to Use a Linux LSF or PBS Cluster and Running via Mechanical and/or Mechanical APDL Application • Select the solve process setting you just specified from the list on the left.



8.
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•



Under Computer Settings, enter the machine name of the head node (lsfclusternode in this example) as the Solve Manager.



•



Select the queue from the Queue drop-down list (earlier in this example, we created the Linux Queue in the Add a Queue (p. 74)section).



•



Click the Advanced button.



On the Advanced Properties dialog: •



Select the Distribute Solution (if possible) option.



•



Specify the number of processors.



•



Click the OK button to close the Advanced Properties dialog.
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9.



Back on the Solve Process Settings dialog, click the OK button to close the dialog and complete the solve process setup.



10. In Mechanical, finish setting up your analysis. When the model is set up and ready to solve, open/launch Mechanical and select the Solve toolbar button drop-down arrow. You will see the solve process name you just defined (in this example, Linux Cluster). Select that process.
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11. The solve will commence. When the solution has completed, the Solution branch and the items underneath it in the project tree will each have a downarrow next to them. 12. Right-click on Solution and select Get Results to bring the solution items down to the local machine.
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How to Configure ANSYS® CFX®, Workbench, and Remote Solve Manager to Submit Solve Jobs to a Microsoft HPC Cluster via RSM Introduction This tutorial walks you through the process of configuring ANSYS CFX, Workbench, and Remote Solve Manager (RSM) to submit solve jobs to a Microsoft HPC 2008 Server Cluster via RSM. You might want to submit your job from your Workstation or laptop and then logoff. Once you submit your job via RSM to a compute cluster your job remains running. You can queue up multiple jobs and then job submission will begin in the order the jobs are queued.



Note Design Point Updates can only be run in Serial for CFX.



Before You Begin This document assumes the following: •



You have installed and configured Microsoft HPC properly and that the compute nodes can access the head node. If Microsoft HPC is not configured properly, contact Microsoft for support before you attempt to install CFX or ANSYS® FLUENT®. You can also download the Getting Started Guide for Windows HPC Server 2008 at http://technet.microsoft.com/en-us/library/cc793950.aspx. This guide is also available with the installation files for Microsoft® HPC Pack 2008 (HPCGettingStarted.rtf, in the root folder).



•



You are local administrator of the cluster and know how to share directories and map network drives. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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How to Configure ANSYS® CFX®,Workbench, and Remote Solve Manager to Submit Solve Jobs to a Microsoft HPC Cluster via RSM If you do not know how to perform these tasks, please contact your Systems Administrator for assistance. You can also go to Help and Support from the Start menu on your desktop. •



You have the machine name of the head node on the Microsoft HPC cluster.



•



You are able to install and run ANSYS, Inc. products, including licensing, on Windows systems. Please see the tutorials on the Download Center at https://www1.ansys.com/customer/ to install ANSYS, Inc. product and licensing installation.



•



If you have any problems with or questions about the installation process please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you.



Configure RSM on the Head Node RSM Services are required if the computer will be accessed by remote Clients (Manager Service required) or a remote Manager (Compute Server service required ,also known as ScriptHost). Use the following steps to install the Manager and Compute Server services as required. Administrative privileges are required to perform these steps. 1.



Before starting the configuration verify that no Ans.Rsm.* processes are running in Task Manager.



2.



Open up Task Manager, choose the Processes tab and look for the following: •



Ans.Rsm.Admin.exe



•



Ans.RSM.JMHost.exe



3.



If these services are running, open up Control Panel >Administrative Tools >Services and stop them.



4.



Open up a Command Prompt and navigate to the C:\Program files\Ansys Inc\v140\RSM\bin directory.



5.



Type AnsConfigRSM.exe –mgr -svr



6.



Create a Shared Cluster Directory. For example, C:\Temp.



7.



Share this directory, giving Full Control to all users submitting jobs.
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Run Caspol 1.



By default, the .NET 3.5 Framework prevents applications from being run over a network. You can allow network execution by running the Microsoft Caspol utility from the command line. The Caspol utility is located under the .NET Framework installation, in C:\Windows\Microsoft.NET\Framework64\.... The security exception executed by the Product Configuration Manager displays the command that opens Full Trust to files on the shared drive: C:\Windows\Microsoft.NET\Framework64\v2.0.50727\CasPol.exe -q -machine -ag 1 -url "file://headnodename/temp/*" FullTrust -name "Shared Drive Work Dir"



2.



Highlight and copy the command.



3.



Open a Command Prompt and paste the copied text, replacing //headnode/temp with the actual name of the Head Node.



Note Do not change the text, “Shared Drive Work Dir”.



Add RSM ports to the Firewall If you have a local Firewall turned on (Server and Client Machines), you will need to add two ports to the Exceptions List for RSM: •



Add port 8140 to Ans.Rsm.SHHost.exe.Config.



•



Add port 9140 to Ans.Rsm.JMHost.exe.Config.



1.



After you add the Firewall, choose Start >Programs >ANSYS 14.x>Utilities >Remote Solve Manager. This opens the Remote Solve Manager Dialog.



2.



Right-click on My Computer in the RSM tree and select Set Password to set the password for the user specified in the previous step. A command prompt will open prompting for the user's password. This is the username and password that you use to log into your Windows machine.
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Add a Compute Server 1.



Right-click Compute Servers in the RSM tree and select Add.



2.



In the Compute Server Properties window, enter the following information under the General Tab:
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1.



Enter a Display Name for the server. This name can be any name that makes sense for you. This example uses MS Compute Cluster.



2.



Enter the Machine Name. This name must be the actual computer name of the head node. This example uses dellwinhpc.



3.



Set the Working Directory Location to Automatically Determined.
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3.



Enter the following information under the Cluster Tab: 1.



Set the Cluster Type to Windows HPC.



2.



Set the Shared Cluster Directory to the directory that is shared out to all the cluster nodes from the Head node. This example will use the shared temp directory \\dellwinhpc\temp. See Step 6 in the section "Configuring RSM on the Head node"



3.



Set the File Management to Use Execution Node Local Disk.
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Add a Queue 1.



Right-click on Queues in the RSM tree and select Add.



2.



In the Queue Properties window, under General, enter a name for this queue. In this example, we will use MS Compute Cluster.



3.



The Compute Server you added previously (MS Computer Cluster) appears under Assigned Servers. Check the box.



4.



Click Ok in the Queue Properties window.



5.



In the RSM tree, expand the Compute Servers item to see the Compute Server you added (MS Computer Cluster in this example).
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Configuring Multiple Network Cards If your Microsoft HPC Cluster is configured using multiple network cards where there is more than one network defined, you must edit some configuration files on the headnode to explicitly define the IP address of the head node. 1.



On the client machine, ping the head node using the fully qualified domain name. For example, open up a Command Prompt and type: ping headnode.domain.com (where headnode is the actual name of the head node). The ping command should return a statement similar to the following: Pinging headnode.domain.com [10.2.10.32] with 32 bytes of data: Reply from 10.2.10.32: bytes=32 time=56ms TTL=61
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Note The IP address is10.2.10.32 in the above example. You will need this address in the following steps. 2.



Navigate to C:\Program Files\Ansys Inc\V140\RSM\bin and locate the Ans.Rsm.JMHost.exe.config and Ans.Rsm.SHHost.exe.config.



3.



Open both files in a text editor.



4.



Add the following text,” machineName="ip_address” , using the IPaddress obtained in Step 1, as shown below.      



Test the Connection •
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Right-click Compute Server>MS Computer Cluster and select Test Server to test the connection and view a report of any problems. Once the test in complete it should read Finished.If it fails, check the steps above to make sure you followed them correctly.
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Note If you see the following exception from script: That assembly does not allow partially trusted callers., run Caspol. See the section, Run Caspol (p. 85).



Configure RSM on the Client Machine Run the following steps from each RSM client (end user) machine that will be submitting RSM jobs to the Microsoft HPC cluster. The last step is a test to verify that communication between the head node and the client machine is working correctly. If the test fails, you must resolve any errors before continuing with this tutorial. 1.



Install ANSYS, Inc. products on each client machine that will be submitting RSM jobs to the Microsoft HPC cluster. When installing, be sure to choose a product that includes ANSYS Workbench. See the tutorials on the Download Center at www.ansys.com for detailed instructions on installing ANSYS, Inc. products.



2.



Click Start> ANSYS 14.0> Utilities> Remote Solve Manager to open the RSM.



3.



Right-click My Computer [Set Password] in the RSM tree on the client machine and select Set Password to set the password for the client machine. A command prompt will open, prompting for the user's password.



4.



Select Tools> Options.



5.



In the Name field, add the name of the head node (dellwinhpc in this example).



6.



Click Add, then click OK .
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Configure CFX Configure CFX on the Head Node 1.



Install CFX 14.x on the head node of the cluster and on the client machines. Ensure that the Microsoft HPC user account has Read and Execute permission for this directory. Typically, adding DOMAIN USERS to the list of users that have access to submit jobs to the compute cluster is sufficient.



2.



Share the Ansys Inc directory on the Head node, typically installed under C:\Program Files as Ansys Inc.



3.



At a Command Prompt type: clusrun mkdir C:\temp
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4.



Ensure that the Microsoft HPC user account has Read & Execute permission for this directory. Typically, adding DOMAIN USERS to the list of users that have access to submit jobs to the compute cluster is sufficient.



5.



Edit the AWP_ROOT140 environment variable to reflect the UNC path to the Head node and the Ansys Inc shared directory. The value of this variable should be as following: \\headnode\AWP_ROOT140\ANSYS Inc\V140.



Configure CFX on the Client Machines Note the following before you begin configuring CFX on the client machine: •



Client machines must be running Microsoft Windows XP 64-bit, Windows Vista 64-bit, Windows 7 64-bit or Microsoft HPC 2008 Server 64-bit.



•



Client machines must have the Microsoft HPC 2008 Server Client Utilities installed.



•



Client machines must have a have a high-end graphics card with the latest graphics driver from the vendor installed. (Contact ANSYS for recommendations).



•



All pre/post processing will be done on the client machines. ONLY the CFX solve jobs will be submitted to the cluster.



1.



To install the Microsoft HPC 2008 Server Client Utilities on the client machines from the headnode network share or the CD, choose Start>Run and type \\HEADNODE\REMINST (where HEADNODE is the actually name of the Head node on the cluster).



2.



Double-click on setup.exe. The installer prompts you to install required programs.



3.



Create a working directory where your case and data files will reside. The working directory should not contain spaces in the directory name.



4.



Share the working directory with the client machines and give them Full Control Access.



5.



Create a cfxccs_options.txt file in the \%USERPROFILE%\.cfx\ directory. You can open up Windows Explorer and in the Address Bar type: %USERPROFILE% to locate the .cfx directory.
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Create a cfxccs_options.txt File 1.



The cxfccs_options.txt file can be created with any text editor. Add the following key words. (The keywords in this file are case sensitive. For example, you cannot use lowercase pathmap; the PATHMAP must be upper case. In addition, you can not have a blank carriage return after the last entry. For example: PATHMAP="C:\Program Files\ANSYS Inc";"\\HEADNODE\ANSYS Inc" PATHMAP=C:\CFX_Working_Dir:\\CLIENT_MACHINE_HOSTNAME\CFX_Working_Dir CLUSTERHOST=HEADNODE



Where HEADNODE is the actual name of the head node, C:\CFX_Working_Dir: is the location of the working directory, and CFX_Working_Dir is the HostName of the client computer and the “shared” name of the working directory.



Note There are other available options you can add to the cfxccs_options.txt file. See the ANSYS Help for more information. 2.



Verify that the cfxccs_options.txt file that you created does not have a hidden file extension. For example, cfxccs_options.txt.txt. You can verify this by going to Windows Explorer, Tools menu, Folder Options . Uncheck "Hide File Extensions for KnownFile Types". You can verify this by choosing Tools> Folder Options from the Windows Explorer. Uncheck Hide File Extensions for Known File Types. If the file does have a hidden extension, you must remove the additional .txt extension.
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Submit CFX Jobs Through Workbench 1.



Open Workbench.



2.



Set up your model.



3.



Choose View >Properties to view Solution Properties.



4.



Select Solution.



5.



Choose the following options for Job Submission via RSM: •



Update Option: Submit to Remote Solve Manager



•



Solve Manager: Headnode (Microsoft HPC Compute Cluster Headnode name)



•



Queue: Headnode (Microsoft HPC Compute Cluster Head node name or another queue you have defined).



•



Execution Mode: Parallel.



•



Number of Processors: Number of cores you wish to run on (depends on license availability).
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Parameter Sets (Design Points) Important If you are doing parallel Design Point updates through RSM, then you will need to setup ANSYS CFX-Solver to run in Serial. Otherwise, the Design Point update will fail.
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How to Configure ANSYS® FLUENT®,Workbench, and Remote Solve Manager to Submit Solve Jobs to a Microsoft HPC Cluster via RSM Introduction This tutorial walks you through the process of configuring ANSYS FLUENT, Workbench, and Remote Solve Manager (RSM) to submit solve jobs to a Microsoft HPC Server Cluster via RSM . This process is useful if you want to submit your job from your workstation or laptop and then log off. Once you submit your job via RSM to a compute cluster, your job remains running. You can queue up multiple jobs and then job submission will begin in the order the jobs are queued.



Important Design Point Updates can only be run with 1 core for FLUENT (-t1).



Before You Begin This document assumes the following: •



You have installed and configured Microsoft HPC properly and that the compute nodes can access the head node. If Microsoft HPC is not configured properly contact Microsoft for support before you attempt to install ANSYS® CFX® or FLUENT. You can also download the Getting Started Guide for Windows HPC Server 2008 at http://technet.microsoft.com/en-us/library/cc793950.aspx. This guide is also available with the installation files for Microsoft® HPC Pack 2008 (HPCGettingStarted.rtf, in the root folder).



•



You are the local administrator of the cluster and know how to share directories and map network drives. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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How to Configure ANSYS® FLUENT®, Workbench, and Remote Solve Manager to Submit Solve Jobs to a Microsoft HPC Cluster via RSM If you do not know how to perform these tasks, please contact your Systems Administrator for assistance. You can also go to Help and Support from the Start menu on your desktop. •



You have the machine name of the head node on the Microsoft HPC cluster.



•



You are able to install and run ANSYS, Inc. products, including licensing, on Windows systems. Please see the tutorials on the Download Center at https://www1.ansys.com/customer/ to install ANSYS, Inc. product and licensing installation.



•



If you have any problems with or questions about the installation process please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you.



Configure RSM on the Head Node RSM Services are required if the computer will be accessed by remote clients (Manager Service required) or a remote Manager (Compute Server service required [also known as ScriptHost]). Use the following steps to install the Manager and Computes Server services as required. Administrative privileges are required to perform these steps. 1.



Before starting the configuration verify that no Ans.Rsm.* processes are running in Task Manager.



2.



Open up Task Manager and choose the Processes tab and look for the following: •



Ans.Rsm.Admin.exe



•



Ans.RSM.JMHost.exe



3.



If these services are running, open up Control Panel>Administrative Tools>Services and stop them.



4.



Open up a Command Prompt and navigate to the C:\Program files\Ansys Inc\v140\RSM\bin directory.



5.



Type in the following command: AnsConfigRSM.exe –mgr -svr



. 6.
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Create a Shared Cluster Directory. For example, C:\Temp.
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7.



Share this directory, giving Full Control to all users submitting jobs.



Run Caspol By default, the .NET 3.5 Framework prevents applications from being run over a network. You can allow network execution by running the Microsoft Caspol utility from the command line. The Caspol utility is located under the .NET Framework installation, in C:\Windows\Microsoft.NET\Framework64\.... The security exception executed by the Product Configuration Manager displays the command that opens Full Trust to files on the shared drive. •



Open a Command Prompt and enter the following text, replacing //headnode/temp with the actual name of the Head Node. C:\Windows\Microsoft.NET\Framework64\v2.0.50727\CasPol.exe -q -machine -ag 1 -url "file://headnodename/temp/*" FullTrust -name "Shared Drive Work Dir"



Note Do not change the text, “Shared Drive Work Dir”.



Add RSM ports to the Firewall If you have a local Firewall turned on (Server and Client machines), you will need to add two ports to the Exceptions List for RSM: •



Add port 8140 to Ans.Rsm.SHHost.exe.Config.



•



Add port 9140 to Ans.Rsm.JMHost.exe.Config.



1.



After you add the Firewall, choose Start >Programs>ANSYS 14.x>Utilities >Remote Solve Manager. This opens the Remote Solve Manager Dialog.



2.



Right-click on My Computer in the RSM tree and select Set Password to set the password for the user specified in the previous step. A command prompt will open prompting for the user's password. This is the username and password that you use to log into your Windows machine.
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Add a Compute Server 1.



Right-click Compute Servers in the RSM tree and select Add.



2.



In the Compute Server Properties window, enter the following information under the General Tab:
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1.



Enter a Display Name for the server. This name can be any name that makes sense for you. This example uses MS Compute Cluster.



2.



Enter the Machine Name. This name must be the actual computer name of the head node. This example uses dellwinhpc.



3.



Set the Working Directory Location to Automatically Determined.
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3.



Enter the following information under the Cluster Tab: 1.



Set the Cluster Type to Windows HPC.



2.



Set the Shared Cluster Directory to the directory that is shared out to all the cluster nodes from the Headnode. This example will use the shared temp directory \\dellwinhpc\temp. See Step 6 in the section "Configuring RSM on the Headnode"



3.



Set the File Management to Use Execution Node Local Disk.



Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.



101



How to Configure ANSYS® FLUENT®, Workbench, and Remote Solve Manager to Submit Solve Jobs to a Microsoft HPC Cluster via RSM



Add a Queue 1.



Right-click on Queues in the RSM tree and select Add.



2.



In the Queue Properties window, under General, enter a name for this queue. In this example, we will use MS Compute Cluster.



3.



The Compute Server you added previously (MS Computer Cluster) appears under Assigned Servers. Check the box.



4.



Click OK in the Queue Properties window.



5.



In the RSM tree, expand the Compute Servers item to see the Compute Server you added (MS Computer Cluster in this example).
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Configure Multiple Network Cards If your Microsoft HPC Cluster is configured using multiple network cards where there is more than one network defined, you must edit some configuration files on the head node to explicitly define the IP address of the head node. 1.



On the client machine, ping the head node using the fully qualified domain name. For example, open up a Command Prompt and type: ping headnode.domain.com



(where headnode is the actual name of the head node). The ping command should return a statement similar to the following: Pinging headnode.domain.com [10.2.10.32] with 32 bytes of data: Reply from 10.2.10.32: bytes=32 time=56ms TTL=61
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Note The IP address is10.2.10.32 in the above example. You will need this address in the following steps. 2.



Navigate to C:\Program Files\Ansys Inc\V140\RSM\bin and locate the Ans.Rsm.JMHost.exe.config and Ans.Rsm.SHHost.exe.config.



3.



Open both files in a text editor.



4.



Add the following text,” machineName="ip_address” , using the IPaddress obtained in Step 1, as shown below.      



Test the Connection •
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Right-click Compute Server>MS Computer Cluster and select Test Server to test the connection and view a report of any problems. Once the test in complete it should read Finished. If it fails, check the steps above to make sure you followed them correctly.
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Note If you see the following exception from script: That assembly does not allow partially trusted callers., run Caspol. See the section, Run Caspol (p. 99).



Configure RSM on the Client Machine Run the following steps from each RSM client (end user) machine that will be submitting RSM jobs to the Microsoft HPC cluster. The last step is a test to verify that communication between the head node and the client machine is working correctly. If the test fails, you must resolve any errors before continuing with this tutorial. 1.



Install ANSYS, Inc. products on each client machine that will be submitting RSM jobs to the Microsoft HPC cluster. When installing, be sure to choose a product that includes ANSYS Workbench. See the tutorials on the Download Center at www.ansys.com for detailed instructions on installing ANSYS, Inc. products.



2.



Click Start> ANSYS 14.0> Utilities> Remote Solve Manager to open the RSM.



3.



Right-click My Computer [Set Password] in the RSM tree on the client machine and select Set Password to set the password for the client machine. A command prompt will open, prompting for the user's password.



4.



Select Tools> Options.



5.



In the Name field, add the name of the head node (dellwinhpc in this example).



6.



Click Add, then click OK .
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Configure FLUENT Configure FLUENT on the Head Node 1.



Install FLUENT (it is only necessary to install FLUENT on the Head node). By default it will be installed in C:\Program Files\ANSYSInc\v14.x\fluent.



2.



Share the FLUENT directory that sits under C:\Program Files\ANSYS Inc\v14.x\ so that all computers on the cluster can access this shared directory through the network.



3.



Edit the AWP_ROOT140 environment variable to reflect the UNC path to the Head node and the Ansys Inc shared directory. The value of this variable should be \\headnode\AWP_ROOT140\ANSYS Inc\V140.
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Configure FLUENT on the Client Machine Note the following requirements before you begin configuring FLUENT on the client machine: •



Client machines must be running Microsoft Windows XP 64-bit, Windows Vista 64-bit, Windows 7 64-bit or Microsoft HPC 2008 Server 64-bit.



•



Client machines must have the Microsoft HPC 2008 Server Client Utilities installed.



•



Client machines must have a have a high-end graphics card with the latest graphics driver from the vendor installed. (Contact ANSYS for recommendations).



•



All pre/post processing will be done on the client machines. Only the FLUENT solve jobs will be submitted to the cluster.



1.



To install the Microsoft HPC 2008 Server Client Utilities on the client machines from the head node network share or the CD, choose Start>Run and type: \\HEADNODE\REMINST



(where HEADNODE is the actually name of the Head node on the cluster). 2.



Double-click on setup.exe. The installer prompts you to install required programs.



3.



Create a working directory where your case and data files will reside. The working directory should not contain spaces in the directory name.



4.



Share the working directory with the client machines and give them Full Control Access.



5.



Map a network drive to the Shared Working Directory. This is required if you will be compiling and loading User-Defined Functions (UDFs).



Submit FLUENT Jobs Through Workbench 1.



Open Workbench.



2.



Right-click on the Setup cell and choose Import Case.
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Note Before you can submit a job to the Microsoft Compute Cluster through Workbench, you must change the FLUENT root path in the FLUENT Launcher to a Universal Naming Convention (UNC) path (\\HEADNODE\fluent) (See Step 2 from the section, Configure FLUENT on the Head Node (p. 106)) and then launch FLUENT after this change has been made. After FLUENT has launched using the UNC in the FLUENT Root Path, FLUENT will save the settings for future runs and this step will no longer be required.
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a.



Right-click the Setup cell and choose Edit.



b.



Start the FLUENT Launcher and change the FLUENT Root Path to a UNC Path pointing to the HEADNODE on the MS HPC Cluster and the shared FLUENT directory name.
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3.



After the run is completed, right-click the Solution cell.



4.



Check the following under the Solution Process: •



Update Option: Submit to Remote Solve Manager.



•



Solve Manager: Type in the name of the Head node on the Compute Cluster.



•



Queue: Choose the MS Cluster Queue.



•



Execution Mode: Parallel.



•



Number of Processors: Type in the number of cores you wish to run on.
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Important Design Point updates can only be run with 1 core for FLUENT (-t1).
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Running the ANSYS Licensing Interconnect and FLEXlm Independently on Windows Introduction This tutorial walks you through installing the ANSYS, Inc. License Manager on a Windows machine and configuring it to run the two components, the ANSYS Licensing Interconnect and FLEXlm, independently. This tutorial assumes that no ANSYS, Inc. products or licensing have previously been installed on this machine or, if products have been installed, all components, including licensing, have been completely removed. Use this configuration if you want to manage your FLEXlm licenses on a server machine independently of the ANSYS, Inc. tools (for example, using Flexera Software's FlexNet Manager). This configuration should be used only by experienced users with well-established licensing procedures. To use the License Wizard
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Running the ANSYS Licensing Interconnect and FLEXlm Independently on Windows to set up a license server that will run the Licensing Interconnect independently of FLEXlm, follow the steps below.



Important Both the FLEXlm and Licensing Interconnect components must be run on the same license server machine. Because FLEXlm is being run independently, you will need to use your license management tools (such as FlexNet Manager) to start/restart FLEXlm or to reread the license file if you make changes to the license file. Even though the Licensing Interconnect will be running independently of FLEXlm, the Licensing Interconnect will still need to “cache” the contents of the FLEXlm license file so that it has the necessary licensing information, such as the licenses contained in the file. Therefore, each time you make changes to the license file, in addition to rereading it in FLEXlm, you must also recache the license file in the Licensing Interconnect by restarting the Licensing Interconnect or by using the Reread the License Manager Settings option of the Server ANSLIC_ADMIN utility. (The ANSLIC_ADMIN utility is discussed in the Verification section below.) We strongly recommend that you review Advanced Licensing Configuration Options in the ANSYS, Inc. Licensing Guide before using this option. If this scenario does not suit your needs, please see the other tutorials available from the Download Center at https://www1.ansys.com/customer/. You can follow this tutorial while actually setting up the license server. To do so, simply make the selections that are pertinent to you or insert your specific information where noted.



Before You Begin We recommend that you have the following information available before you begin this tutorial: •
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An account on the ANSYS Customer Portal. If you do not have an account, you may register at https://www1.ansys.com/customer/ to receive your own account. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.



•



The license file that was created for this machine from ANSYS, Inc., saved to a directory. FLEXlm should already be running with this license file.



•



Open port numbers for both the FLEXlm and ANSYS Licensing Interconnect. Defaults are 1055 and 2325, respectively. To verify that these port numbers are available, open a command line and enter the following command: netstat -a -p tcp



You will see a list of active ports. If 1055 and 2325 are listed, they are already in use and cannot be used for ANSYS, Inc. licensing. This tutorial assumes you are using the default ports. •



Your local machine's name, to specify as the license server.



You must also already have FLEXlm running in your organization and have wellestablished licensing procedures. You should also verify that you are running on a supported platform. ANSYS, Inc. supports both 32- and 64-bit systems running Windows XP, Vista, and Windows 7. For detailed information on which products are supported on which platforms, please see the ANSYS, Inc. Windows Installation Guide, which is available for download when you download ANSYS, Inc. products or as a printed manual if you receive installation media. Verify that you have sufficient disk space to download, uncompress, and install the products you will be installing. If you have any problems with or questions about the installation process please log a Service Request on the ANSYS Customer Portal. A Systems Support Specialist will respond to assist you. This tutorial is divided into three sets of instructions: •



Product Download Instructions: This set of instructions describes the download and extraction process.



•



License Manager Installation: This set of instructions describes the license manager installation and configuration to run the Licensing Interconnect independently of FLEXlm.



•



Verification



Product Download Instructions 1.



From the Customer Portal, click on Download Software. Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
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Running the ANSYS Licensing Interconnect and FLEXlm Independently on Windows 2.



The ANSYS Download Center Wizard page displays an overview of the download process. Review the overview and click Next.



3.



For the Download Type, choose Current Release. Click Next Step.



4.



Choose the hardware platform for which you want to download installation packages. You can select only one platform at a time. You will need to repeat the download procedure for each platform that you want to download. Click Next Step.



5.



Choose the license manager to download. We also recommend that you choose the ANSYS 14.0 Release Documentation so that you have access to the installation and licensing documentation. Click Next Step.



6.



Click the ANSYS License Manager Download link, and the ANSYS Documentation Download link if chosen, to begin the product download(s). You can also click on the Installation and Licensing Documentation link to view the ANSYS, Inc. Licensing Guide for more information.



7.



After the downloads have completed, uncompress each package using standard uncompression utilities for your specific platform. We strongly recommend that you extract the files into a new, temporary directory.



8.



Begin the license manager installation as described in the next section.



License Manager Installation The License Manager controls access to the ANSYS, Inc. products you have purchased. You must complete the License Manager installation to run ANSYS, Inc. products. 1.



Launch the ANSYS, Inc. Installation Manager by double-clicking setup.exe from the directory where you downloaded and/or uncompressed the installation files from the previous section.



2.



On the ANSYS, Inc. Installation Manager screen, click Install ANSYS, Inc. License Manager.
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3.



You will see a warning stating that if the license manager is currently running, it will be shut down. This tutorial assumes that you have not previously installed the products or the licensing on this machine, and you are not pointing to a network license server machine. You may safely ignore this message and click OK.



4.



The license agreement appears. Read the agreement, and if you agree to the terms and conditions, click I Agree. Click Next.



5.



The directory where the license manager will be installed is shown in the Install Directory field. You cannot specify an installation directory; the license manager must be installed into :\Program Files\ANSYS Inc. Click Next.



6.



The ANSYS, Inc. License Manager is selected as the only product available to install. As with the product installation, the required and available disk space numbers are shown. Click Next.
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7.



The licensing file dates are compared to ensure that the most recent version of the licensing files are being used. This tutorial assumes that this is the first time you are installing ANSYS, Inc. products on this machine; therefore, no licensing files will already exist and the files included with the installation package will be used. Click Next.



8.



A summary screen appears that lists the products to be installed. Because this is a license manager installation, the ANSYS, Inc. License Manager is the only product listed. Click Next. The license manager installation begins.



9.



When the license manager installation completes, click Next to begin the license manager configuration.



10. The License Server Installation Configuration window appears, and several configuration steps will be completed. When the ANSYS, Inc. License Wizard appears, select Run the ANSYS Licensing Interconnect and FLEXlm Independently under Type of License Server at the bottom of the screen.
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11. A message box will immediately appear, warning you that you are about to proceed in a non-standard manner and to exercise caution.
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Click Continue on the message box. 12. The message is repeated in a note at the top of the window and the steps are updated to reflect the new process.
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Click Continue. 13. Next, you need to specify the location of an existing license file that was created for this server machine and that contains FLEXlm licenses for ANSYS, Inc. products. Note that the license file will not be installed, (i.e., moved into the default ANSYS license file location), but will be cached so that the ANSYS Licensing Interconnect has the necessary licensing information, such as the licenses contained in that file.
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Click Continue to display a Browse dialog. 14. Browse to the location of the license file, select the file, and click Open on the file selection window. 15. Next, you must specify the license server information for the servers specified in the license file. This step is required only if the ANSYS, Inc. products will be installed in the same directory as the license manager. If not, you can safely skip this step. This tutorial will proceed with this step.
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Click Continue. 16. You will then see the port numbers being used by the ANSYS licensing. This tutorial assumes you are using the default ports shown. Then specify the hostname. Type in the machine name of your license server machine and click OK. The hostname and FLEXlm port number must match those specified in the license file.
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17. You must now start the ANSYS, Inc. License Manager. This step starts only the Licensing Interconnect. You may need to also start FLEXlm using the license management tool(s) you use to manage FLEXlm (such as FlexNet Manager or LMTOOLS), if FLEXlm is not already running.
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Click Continue to start the ANSYS, Inc. License Manager. 18. You will then see another message reiterating that you are running the ANSYS Licensing Interconnect and FLEXlm independently. Read this message carefully and click OK.
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19. Click Exit to close the License Wizard. 20. Click Exit to close the Licensing Server Installation Configuration screen. 21. Click Finish to close the License Manager Installation screen. 22. Click Exit to close the ANSYS, Inc. Installation Manager.



Verification 1.



Choose Start> All Programs> ANSYS, Inc. License Manager> Server ANSLIC_ADMIN Utility to launch the server ANSLIC_ADMIN utility.



2.



Check the Status window in the Server ANSLIC_ADMIN utility to verify that FLEXlm and the Licensing Interconnect have started correctly.
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